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All information, content, and materials available in this document are for general 
informational purposes only. The content on this posting is provided "as is;" no 
representations are made that the content is error-free or up to date. Designers should test 
their design in XHTML often and keep back up files at all times.

The document shows functionality that is still under development, and may or may not 
become available in Workiva’s sole discretion. Some features may never become 
commercially available. Whilst Workiva will uses commercially reasonable endeavours to 
communicate with its developer community, features and rollout timings cannot be 
guaranteed and may change without notice. Designers should test all exports regularly.

Please check you have the latest Widget. Go to Design Reporting Support Hub to download.
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Contact

https://support.workiva.com/hc/en-us/articles/4574699768724-Designed-Reporting-Support-Hub


Introduction
Welcome to Workiva! We are a cloud-based connected and reporting compliance 
platform that enables the use of connected data. Workiva is also a great platform 
for design. Follow these guidelines for the best experience for you and your client. 
Don’t be too daunted! You will be able to create great looking reports, without 
worrying about out of date copy and with a small amount of time investment up 
front you’ll be a pro in no time. The Widget is your design reference and 
accompanies many online video workshops to help get you started.

Workiva is flexible regarding design. Design can be achieved within the Workiva 
platform, exporting content to Adobe InDesign or a mixture of both.

The Widget Platform guidelines gives 
you all the guidance about achieving 
design within Workiva. You will need 
this Widget also.

The Widget InDesign guidelines 
contains information about using 
content from Workiva but using 
InDesign to create the design.

The Widget Export for web is also available.

TheWidget-Premium compliments TheWidget-Platform. 
Where you see this symbol in TheWidget-Platform - use this 
Premium document.

3

Welcome

https://support.workiva.com/hc/en-us/articles/4574699768724-Designed-Reporting-Support-Hub
https://support.workiva.com/hc/en-us/articles/4574699768724-Designed-Reporting-Support-Hub
https://support.workiva.com/hc/en-us/articles/4574699768724-Designed-Reporting-Support-Hub


Designed Reporting 
Support Hub
[Bookmark this] so you can find it 
again easily! The hub contains a 
wealth of resources which will make 
your journey to structured data and 
design worthwhile.

Watch a webinar!
[Quick look to how design works with 
Workiva]

[See how a client and agency works 
together]

Watch a workshop!
These workshops take you on a 
journey from an ‘Introduction 
to structured content’ to ‘Building 
digital value’ - especially for designers.

Stuck?
We have many short videos addressing 
individual topics. Don’t struggle or get 
frustrated - check out this section.

Why not get certified?
On the Workiva Learning Hub,
there are three modules for designers 
to receive a certification award.

[Design Reporting: Starting off the 
right way]
This module is for designers new to 
Workiva. We introduce the power 
of structured content and ways 
designers can use Workiva. Join us on 
a tour of the platform as we show you 
the best way to start your project for 
best results further down the line.

[Using Workiva and InDesign]
Module two looks at on-platform 
communications for designers, flowing 
content to Adobe InDesign while 
maintaining 100% data assurance, and 
managing exports and RGB and CMYK 
workflows in a way that meets your 
online and print quality requirements.

[Workiva, a design platform]
Here we explore using Workiva for all 
your design needs. Find out design 
tools from creating charts, using 
presentations, and pushing content 
online via the Workiva web API.
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Getting started guides
If you are new to Workiva and are looking for a quick 
guide as you get more familiar with Workiva and 
Design Reporting, start here with our Quick Start 
Guides! Available in German, Italian, Swedish, French, 
Spanish and English.

The Widgets
The Widgets - Platform and InDesign Integration are 
your guide on how to’s and best practices, for the 
whole design process. Download the latest edition on 
the Design Reporting Support Hub.

Help guides
Short, visual instructional guides to aid in quick 
understanding of the processes.

General platform support
If you need support about the Workiva platform, there 
are many resources at [Workiva Support]. Here there 
is information on XBRL, Wdata, documents and 
spreadsheets all the way to filing.

If you are new to Workiva, there are loads of basic 
guides to the Workiva platform [here].

Need to contact a human?
So what do you do after you have checked all the help 
material? The best way to find further help is to 
contact the Customer Success Manager. This CSM is 
the person dedicated to your client’s account. They 
can help you straight away or direct your question, if 
design related, to Workiva’s Design Support team.

Out of hours
If you are logged into a Workiva account, you can 
submit a ticket at [Workiva Support]. A member of 
the Support staff will respond quickly. This support 
is 24/7.
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Object frames allow greater 
flexibility and freedom for 
document layout.

These allow the user to place content 
into a moveable box that can be sized 
and positioned as desired.

There are 4 different types of object 
frames and these are covered in their 
own sections.

Top tip: The frame formats are 
not interchangeable, so you will 
need to choose the correct one 
for the right effect when placing 
it. i.e. to create a table you will 
need to insert a floating table.

This section covers elements that are 
common to all the Object frames.

The object anchor
All object frames will have an 
anchor. This is required to 
hold the frame to the page it 
sits on and can affect the 
object frames position.

An anchor’s location can be identified 
by clicking on a Floating Objects 
frame. Each frame will have its own 
anchor.

In the example below, we can see that 
by selecting the floating anchor image 
that there is an actual anchor for that 
image before the word All.

Moving an anchor
An anchor can be moved at anytime. 
If a Floating Object is selected then 
hovering over its anchor will change 
the mouse icon to a hand and the 
anchor can be clicked and dragged 
around the page.

An anchor will snap to the nearest 
column and paragraph as it is moved 
around the page.

Top tip: Moving an anchor can 
affect the position of text around 
your object frame, if text wrap has 
been applied.

Editing text around 
an anchor
Currently, anchors cannot be locked 
and move with text. If the text around 
an anchor is edited you may notice 
that when the anchor moves that the 
object will also move.

This is particularly noticeable if the 
anchor changes columns due to text 
editing. The object will need to be 
moved back to its original position 
if needed.

Selecting an existing 
Object frame
When text on the page is hovered over 
with the mouse cursor, a type icon 
appears but when a selectable object 
is hovered over the icon changes to 
an arrow. 

This is the same for Object frames and 
inline tables. To select the Object 
frame, just click on it when the icon 
changes to a pointer whilst hovering 
over it.

Selecting the frame will make the 
objects edge appear highlighted with 
a blue border. It can now be dragged 
around, resized, have its properties 
altered and its content edited (it may 
require a further click into the frame to 
start editing inside it).
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Object Properties
The Object Properties panel is used 
to control the layering/text wrap, 
margins, positioning and padding 
of your frames.

The properties for an Object frame 
will only be available when the frame 
is selected. 

On the following pages we will break 
this panel down.

The same properties will appear for all 
4 types of Object frame but not all 
properties may apply i.e. amending 
the padding values has no effect on 
floating images for instance.

Text Wrap
Under the Text Wrap heading is 
a dropdown menu where you can 
choose how the text around the frame 
will interact with it.

Wrap text
Wrap text will cause the frame to push 
any inline text it sits over to ‘wrap’ 
around the frame.

Top tip: Wrap text will not affect 
other frames with text in. It will only 
affect inline text sitting under the 
placed frame.

To effect the distance of the text wrap 
from the object see Margins.

In front of text
This will make the object sit in front of 
any inline content it is placed on.

Here is an example of a Text box 
placed in front of this text. 

This frame is easily selectable as it sits 
over the inline content.

Behind text
This will make the object sit behind 
any inline content it is placed on.

Here is an example of a Text box 
placed behind this text.

This text is inline and this is why the 
box can be adjusted to sit partly under 
the text. The text box anchor is set at 
the start of this paragraph which 
means the box will move with the text. 

Top tip: An object frame placed 
behind inline content i.e. the text 
example above, can be hard to 
select if it is completely covered by 
inline content. In our example, the 
text had to be moved first, so the 
position of the frame could be 
adjusted. 
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Margins
These settings are greyed out unless 
Wrap text is applied and then they can  
be adjusted to adjust the space 
between the edge of the frame and the 
text that is wrapping around it.

Size
Although an object can be resized at 
any time by just clicking and dragging 
on any of the 8 points around its edge, 
it can also have exact size 
measurements applied in the 
properties panel.

Top tip: Holding down the shift key 
whilst manually resizing a frame will 
make the size increase/decrease 
proportionally.

In the Size Properties you can enter an 
exact Height and Width and also tick 
‘Preserve aspect ratio’ to make these 
sizes increase/decrease proportionally 
when either is changed.

Position
Exact positioning can be set here. 
There is a Horizontal X position and 
a Vertical Y position. The numbers 
reflect the page position of the top left 
point of the selected Object.

Top tip: X Position 0 and Y position 
0 are the top left corner of the page.

Padding
Padding is the space between the 
frame edge and the content within 
the frame.

Padding only affects text boxes. 

Top tip: Padding does not 
affect table, image or chart objects.

When created, a floating text box, 
by default, will have all padding set 
to 0.25cm / 1 inch (dependent on your 
document unit settings).

The padding value can be set to 
anything between 0 and 22 (regardless 
of unit setting) 

All 4 edges padding can be set 
independently of each other.

Widening the panel
Sometimes it can be hard to see 
the full measurements in the Panels. 
This is easy to remedy.

Hovering over the lefthand side of the 
panel will display a 2 way arrow icon. 
When that is displayed you can just 
hold down the left mouse button and 
drag to whatever width you require.
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Re-ordering objects
The order of objects (how objects layer 
on top of one another) is defined on a 
page by page basis and is based on the 
order of insertion and what text 
wrapping option has been applied. 

Think of text wrap as layers that either 
sit above or below inline content. 

Each new object will become the top 
object of the layer it is set to. Visually, 
it will be above any other objects on 
that layer if moved in front of them. 

If you need to move an object, on a 
layer, in front of or behind another 
object then you will need to adjust 
the order. This is done by using the 
Reorder dropdown. 

With the Object selected you can 
then use the Reorder dropdown to 
move the object to 1 of 4 options 
on that layer. 

Move Forward and Move back will 
move the object 1 place up or down 
the order whereas Send to Front and 
Send to Back will make the object 
either the top or bottom object in 
the order.
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Aligning objects
Although objects can be positioned 
and aligned manually by entering in 
exact measurements for their X and/or 
Y axis, we have included inbuilt tools 
to ease this process.

Snap to
A common tool for aligning objects 
is a ‘Snap to’ function. As an object is 
moved around the page and gets 
either near the center of the page or 
another object, red lines will appear 
showing where the center of the 
page is and where another objects 
edge or middle may align with your 
selected object.

The object being moved around will 
snap to one or more of these lines if 
moved close enough. This will mean 
the object will be aligned on the edge 
that has snapped to any red line.

Top tip: ‘Snap to’ negates the need 
to enter exact measurements every 
time objects align.

In our example Text box 2 is aligned 
along the top edge with Text box 1 and 
it is also aligned with the center of the 
page on its right-hand edge.

Alignment tool
To quickly align multiple objects you 
can select more than one at a time by 
holding down the SHIFT key and 
clicking on all the required objects. 

With the objects selected you can use 
the Align/Distribute dropdown menu 
to align them or distribute them.

Align
Objects can be aligned on either 
the Horizontal or Vertical axis and 
whichever option you then choose. 
i.e. Horizontal & Center will take the 
center point of your selected objects 
and align all the objects centers 
with that horizontally.

Distribute
Distribute will only work for a selection 
of 3 or more objects, as it will equalise 
the space between those objects on 
the selected axis.

So if you choose 4 objects and 
distribute on the Horizontal axis then 
the space across the page between 
objects 1, 2, 3 and 4 will be made 
identical. This does not resize the 
objects but just moves the center 
objects to the correct position.

Top tip: If the center objects 
overlap the outer objects when 
using distribute, you may not get 
the result you require.
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Copying and pasting 
objects
Objects can be copied and pasted 
between pages and sections. 

To copy one or more objects between 
pages and/or sections, select the 
object or multiple objects (hold down 
shift to select more than one at a 
time), click ‘Ctrl + C’ or ‘Command + C’, 
navigate to where you wish to paste 
them in your document, place your 
cursor somewhere on the page and 
paste ‘Ctrl + V’ or ‘Command + V’. 

To get your required layout you may 
need to re-position the objects and 
their anchors on the new page.
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The text box is used for inserting 
a floating object that can be 
moved anywhere on the page.

As the name suggests this box is 
used for adding floating text onto 
a page layout.

As well as text, the box can have a fill 
and border added. 

When to use
If you have a text layout that is not 
achievable using the platforms default 
inline format then a text box could be 
the solution.

How to create
To insert a text box, 
go to the main menu 
and under the Edit 
tab, click on the 
Insert drop down and 
choose Text Box.

A small crosshair will 
appear which can be 
moved around the 
screen with your mouse. 

You can either just left click on the 
page you wish the box to appear on 
and a default sized box will appear 
or you can left click and hold your 
mouse button down to draw a larger/
smaller box. 

The box can be resized at anytime, so 
you don’t have to get the size exact at 
the first attempt.

Top tip: Holding down the shift key 
whilst placing and/or resizing a 
text box will size the box 
in proportion.

How to add text
When first created a text box will start 
with the cursor inside the box and you 
can type or paste text straight into it.

Styles can also be applied to the 
content.

If you have clicked off of the text box 
then one click will select the box but it 
requires a double click to make the 
cursor active again within the box.

How to delete
When a box is first created you need to 
click on the border of it and click 
delete to remove it.

If you have unselected the box then 
just clicking on the box once and 
pressing delete will remove it.

If you click and move a box you will 
need to select it again to delete it.

The box anchor
The box anchor is what links the 
box to the page and can affect the 
boxes position. See object frames 
for a full description.

Object Properties
Object Properties are where you 
can exactly set size, padding, etc. 
See Object frames for a description.

Top tip: A text box can be changed 
to any other shape in the object 
properties panel.

Layering and alignment
See Object frames for a description.
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Adding a fill
To add a fill to your text box you need 
to have the object selected, click on 
the Edit menu and then click the 
dropdown for the Fill color picker. 

Clicking on a color swatch will apply it 
to the selected object.

See our section on the Color picker 
for a full description of how the color 
picker works.

An applied color can also have a 
transparency set here.

Top tip: Previous settings will 
be held in the fill dropdown but will 
not be applied to a new box unless 
re-selected.

Adding a border
Adding a border to your text box is 
done by selecting the object, clicking 
on the Edit menu and clicking onto the 
rule picker dropdown menu.

Here you can set the rule weight, style 
and color.

Select the rule weight and style before 
picking the color, as once the color is 
selected the panel will close and the 
settings will be applied to your box.

Top tip: Currently, only weights 
from 1pt though to 10pt are 
selectable from the weight menu.
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A floating table allows the user 
to create and place a table 
anywhere on the page.

Apart from allowing the user to freely 
move a table around the page the 
functionality is generally the same 
as an inline table, although images 
cannot be placed into a floating table.

Top tip: Unlike inline tables, an 
image cannot be placed within a 
floating table.

When to use
If you have a table position that is not 
achievable using the platforms default 
inline format then a floating table 
could be the solution.

How to create
To insert a floating table, go to the 
main menu and under the Edit tab, 
click on the Insert drop-down and 
choose Table/Floating.

A default 5 column x10 row table will 
appear on the page. Rows or columns 
can be added or removed from this 
table as they would be from an inline 
table. 

Top tip: Holding down the shift key 
while resizing a floating table will 
size the box and table cells 
in proportion but not any text 
within the cells.

How to add text
You need to click a cell inside the table 
to type or paste text into it.

Styles can also be applied to the 
content. If you have clicked off the 
floating table then hovering over it will 
display an outline of the cells and one 
click will select a cell.

How to delete
To delete a floating table you need to 
click on its edge and then delete.

The box anchor
The box anchor is what links the 
floating table to the page and can 
affect the tables position. See object 
frames for a full description.

Object Properties
Object properties are where you 
can exactly set size, margins, etc. 
For or tables, margins cannot be set. 
See Object frames for a description.

Object Properties are where you 
can exactly set size, padding, etc. F 
See object frames for a description.

Adding a fill
A fill can be added to any selected 
cells in the same way it is done 
for an inline table by using the fill 
color picker.

Adding rules
Rules are added to cells in the same 
way as they are for inline cells by 
selecting the cells you want to apply 
a rule to and using the borders 
dropdown to select the weight, style, 
color and edge or edges to apply the 
rule to.

Linked text/data
Data and text can be linked within the 
cells of a floating table, just as it can 
with an inline table.

Layering and alignment
See Object frames for a description.
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A floating image allows the user 
to place and move an image 
around anywhere on the page.

When to use
Design will often require images to sit 
outside the constraints of a standard 
page grid and this allows you the 
freedom to do that.

How to create
To insert a floating image, go to the 
main menu and under the Edit tab, 
click on the Insert drop down and 
choose Image / Floating.

Browse to the location of your image, 
select and open.

The image will size in proportion to 
fill the column width it is placed into 
unless the exact DPI falls under that 
size, in which case it will display as 
the DPI of the image. 

Top tip: A Photoshop image with a 
fixed DPI will import to that size 
unless the column width is smaller.

Top tip: A cropped and exported  
InDesign image will retain the 
images underlying DPI regardless 
of export settings and will import 
to that size unless the column 
width is smaller.

How to resize
The image can be resized at any time 
by just clicking and dragging on any of 
the 8 points around its edge.

Top tip: Hold down the shift 
key while resizing a floating 
image to resize it in proportion.

How to delete
To delete a floating image you need to 
click on it and then delete.

The box anchor
The box anchor is what links the 
floating image to the page and can 
affect the boxes position. See object 
frames for a full description.

Object properties
Object properties are where you 
can exactly set size, margins, etc. 
For images padding has no effect. 
See Object frames for a description.

Layering and alignment
See Object frames for a description.

Updating
Unfortunately, it is not yet possible to 
update an image via its link.

To replace an image you will need to 
upload it again and apply any previous 
size and position settings.
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Adding a fill
To add a fill to your image you need 
to have the object selected, click on 
the Edit menu and then click the 
dropdown for the Fill color picker. 

Clicking on a color swatch will apply it 
to the selected object.

See our section on the Color picker 
for a full description of how the color 
picker works.

An applied color can also have 
a transparency set here.

Top tip: Previous settings will 
be held in the fill dropdown but will 
not be applied to a new box unless 
re-selected.

A fill applied to an image is only 
visible if the image is a PNG 
with transparency. 

In our example 
here we have a 
white circle PNG 
with an Orange 
fill applied to 
the box.

Adding a border
Adding a border to your image is done 
by selecting the object, clicking on the 
Edit menu and clicking onto the rule 
picker dropdown menu.

Here you can set the rule weight, style 
and color.

Select the rule weight and style before 
picking the color, as once the color is 
selected the panel will close and the 
settings will be applied to your box.

Top tip: Currently, only weights 
from 1pt though to 10pt are 
selectable from the weight menu.
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A floating chart allows the user 
to create and place a chart 
anywhere on the page.

Apart from allowing the user to freely 
move a chart around the page the 
functionality is generally the same 
as an inline chart.

When to use
If you have a chart position that is not 
achievable using the platforms default 
inline format then a floating chart 
could be the solution.

How to create
To insert a floating chart, go to the 
main menu and under the Edit tab, 
click on the Insert drop-down and 
choose Chart/Floating and then select 
the type of chart you require.

When you insert a chart, it will have 
default colors, fonts (Arial) and  default 
dimensions, which are 613 pixels wide 
by 380 pixels tall (this is regardless of 
the size or orientation of your page. 

How to resize
The chart can be resized at any time by 
just clicking and dragging on any of 
the 8 points around its edge.

Resizing will not change the size of any 
text within the chart.

Top tip: Hold down the shift 
key while resizing a floating 
chart to resize it in proportion.

Styling the chart
Adjusting and styling the chart is the 
same as it is for an inline chart. Please 
see The Widget – Platform for how to 
do this.

How to delete
When a chart is first created you need 
to click on the border of it and click 
delete to remove it.

If you have unselected the chart then 
just clicking on the box once and 
pressing delete will remove it.

If you click and move a chart you will 
need to select its edge to delete it.

The box anchor
The box anchor is what links the 
box to the page and can affect the 
boxes position. See object frames 
for a full description.

Object properties
Object properties are where you 
can exactly set size, margins, etc. 
Padding has no effect on a chart. 
See Object frames for a description.

Layering and alignment
See Object frames for a description.

Linked data
Data can be linked to your chart within 
the chart data spreadsheet, just as it 
can with an inline chart.
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Adding a fill
To add a fill to your chart you need 
to have the object selected, click 
on the Edit menu and then click the 
dropdown for the Fill color picker. 

Clicking on a color swatch will apply it 
to the selected object.

See our section on the Color picker 
for a full description of how the color 
picker works.

An applied color can also have 
a transparency set here.

Top tip: Previous settings will 
be held in the fill dropdown but will 
not be applied to a new box unless 
re-selected.

Adding a border
Adding a border to your chart is done 
by selecting the object, clicking on the 
Edit menu and clicking onto the rule 
picker dropdown menu.

Here you can set the rule weight, style 
and color.

Select the rule weight and style before 
picking the color, as once the color is 
selected the panel will close and the 
settings will be applied to your box.

Top tip: Currently, only one weight 
can be applied to a floating chart.
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Character spacing allows the 
user to tighten or loosen the 
space between characters in 
words or whole paragraphs.  

In the Design world text is often 
adjusted using character spacing 
(tracking) and this can now be done on 
the platform either manually to 
selected characters/words or applied 
at a style level, where it will then be 
applied to all instances of that style 
throughout a document.

When to use
If your chosen font looks too tight or 
wide then character spacing is great 
for adjusting this globally.

Sometimes font spacing can look 
peculiar at a larger or smaller size and 
again, character spacing allows these 
instances to be adjusted. 

How to apply
Style level
To apply character spacing at the style 
level of a document you need to open 
the style guide for your document.

Edit Style Guide can be found at the 
bottom of the style list.

Once in the style guide, select any 
style you wish to set Character 
spacing to and in the right-hand 
panel, at the bottom, you will see 
Character Spacing. 

Top tip: The measurement used for 
character spacing is very similar to 
what designers should be used to. 

You can enter a manual value in 
here or choose from one of the pre-
created settings. 

Once you have amended all the 
necessary styles, click Publish 
to automatically apply them to 
your document.

Top tip: Unless character spacing is 
locked in the style guide, any 
manually applied character spacing 
will supersede a style’s character 
spacing.

Manual level
To apply character spacing manually, 
you need to select the text or 
character you wish to affect and then 
under the Edit menu click on the 
Character Spacing dropdown.

You can either choose from the pre-
created settings or type in your own 
custom value.

The change will take immediate effect 
and the selected texts spacing will 
change. You can use the arrow keys 
in Custom value to tweak this 
measurement up or down in realtime.
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SVG (Scalable Vector Graphic) 
is an image based format often 
used for logos, infographics 
and icons. 

An SVG is built using mathematical 
calculations rather than pixels. 
This allows an SVG to scale to any 
size without any loss in quality, 
whereas a (rasterised) JPEG or PNG, 
which are built with pixels, can 
decrease in quality, as the size 
is increased/decreased.

In the example above you can easily 
see the difference between a vector 
image and a raster image.

SVGs can also be very small in file size, 
which can be a consideration if the file 
size limit for the iXBRL is low.

SVGs are also useful on the web, 
as text within the images can be 
searchable from a browser.

Jurisdiction 
consideration - Not all 
regulators will accept 
use of an SVG in filing 
submissions, so check 
whether the format is 
acceptable or that the 
process can incorporate 
them before using them.

When to use
As stated earlier, SVGs are great for 
logos, infographics and icons and 
where these are used, it may be 
preferred to use an SVG. Regardless of 
the size, the image will appear crisp.

How to use
Inserting an SVG is just the same 
as inserting any image. 

The only difference being that SVG is 
now a selectable format.

Place your cursor where you wish the 
image to appear and from the Insert 
menu choose either Inline or Floating.

You can then browse to the images 
location and select it.

Top tip: If you choose a Floating 
image for your SVG, it will make it 
much easier to size and move 
around your page.

Placed as an Inline image
See TheWidget–Platform on how to 
work with inline images.

Placed as a floating image
See Floating image for information on 
how to manage the image if it has 
been inserted this way.

How SVGs appear 
in exports
For a PDF export from the platform, 
SVGs export as png format. They 
currently export as SVG for the 
platform XHTML export.
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The Color picker has been 
updated in the color palette 
and now supports Document 
level colors (File colors).

As well as File level colors being 
added, you can also export/import 
color settings between documents/
users and clear your current settings.

When to use
This should always be used for a 
documents colors, as it means all 
users can now select from the same 
color list while working on a file.

Setting up a documents colors is best 
done at the start of the document 
setup but it can be updated at 
any time. 

Top tip: Double check your file 
colors when first input. The palette 
colors are not themselves linked 
to any content and therefore 
any color changes will need to 
be re-applied.

How to use
The color picker works much as before 
(See Color management in TheWidget-
Platform) 

Any action that requires the user to 
choose a color will involve the color 
palette but to initially set up a 
documents colors, you just need 
to access the palette. 

Top tip: You can quickly access the 
color palette from the Highlighter 
dropdown.

The color picker
If there are no previous colors added 
to the color palette, then both ‘My 
colors’ and ‘File colors’ will be empty.

My colors
My colors - this is for adding colors 
that are linked to your login and will be 
displayed in this color picker for all 
documents you access.

File colors
File colors - this is where a document 
Admin can set the colors viewable by 
all users for that document. Each 
document will have its own file colors.

Adding a new color
To add a color to the color palette 
for My Colors or File Colors, you need 
to type or paste your colors Hex 
reference into the relevant box and 
click add.

This will add the color to the left box 
of your chosen color list and 
automatically close the palette. 
This will probably be changed so 
that the palette stays open instead. 

If you re-open the palette, you will now 
see the added color in the list and if 
the color is hovered over then its HEX/
RGB values will be displayed.
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Any additional colors added to this list 
will appear to the left of any existing 
colors and move all the current colors 
along one. 

Top tip: File colors has a limit 
of 64 colors. My colors has a 
limit of 16 colors.

If the limit is reached then the last 
color will drop off the end of the list 
when a new one is added. 

In our example below, a new green has 
been added which has pushed the blue 
color along one place.

These colors can now be easily 
selected in the color picker 
and applied to content in the 
normal manner. 

Clearing a color list
A color list can be cleared at any time 
but you will need to be the owner of 
the list to do this.

Open any color palette and under the 
dropdown for the color list you wish 
to remove, select Clear.

This will open a window asking you to 
confirm your decision to clear the 
current colors. You also have the 
option here to export and clear, which 
will export a copy of the color list in 
case you need to re-import it.

Clicking clear will remove all colors 
from the list.

Importing/exporting 
a color list
This allows a user to share color 
lists with other users, documents 
or workspaces.

The color list exports as a text 
document (.txt), this allows for easy 
editing outside the platform and 
can allow an experienced user to re-
order a color list quickly.

Exporting
To export a color list, open the color 
palette, click on the list dropdown and 
click export. 

A .txt file will be downloaded to your 
downloads folder. 

Importing
To import a color list, open the color 
palette, click on the list dropdown and 
click import. 

This will open up an import screen 
where you can browse to your .txt 
color file. You can choose to either 
Replace all the colors with your new 
import or just Add only new colors. 
There is also an option to download 
an import template (basically it will 
export your current list)
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Editing a color list txt file
A .txt format was chosen as any user 
should be able to edit this locally 
without the need for specialist 
software.

In the example below we have 2 colors 
specified in our list and they are the 
green and blue we have seen earlier in 
this guide.

The colors are displayed as per their 
Hex code values and the order is from 
first to last and can either be on 
separate lines or separated by a 
comma. This is the same order they 
will appear in the picker.

So if we change the order here and re-
import then the order will change on 
the platform.  You can also add or 
remove colors in this txt file.
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Shapes and lines enable users, 
as the name suggests, to add 
lines and shapes to their pages.

Shapes are identical to our floating 
text boxes apart from they start as the 
selected shape and have a pre-applied 
default fill and rule applied (text can 
still be inserted into shapes).

There are 3 options for lines.

When to use
If you have a layout that requires a 
shaped box (whether for text or not) or 
a line or set of lines then the options 
here may suit your needs.

How to create
To insert any shape or line, go to 
the main menu and under the Edit 
tab, click on the Insert dropdown 
and choose the Shape dropdown.

You will be presented with a view 
of the shapes and lines you can 
choose from. 

Click on the shape or line you want 
and then move your cursor back onto 
the page to insert it.

A small crosshair will appear which 
can be moved around the screen with 
your mouse. 

You can either just left click on the 
page you wish the shape/line to 
appear on and a default sized shape/
line will appear or you can left click 
and hold your mouse button down to 
draw a larger or smaller shape/line. 

The shape/line can be resized at 
anytime, so you don’t have to get the 
size exact at the first attempt.

Top tip: Holding down the shift key 
whilst placing and/or resizing a 
shape/line will size the shape 
in proportion or the line at varying 
15o angles.

Top tip: To multi-insert a shape/
line just right-click rather than left 
click when picking it from the 
panel and then proceed to left 
click as many times as you want it 
on the page. 

To stop inserting the shape/line, 
press ESC.

Shapes with extra points
Some shapes will have a small 
diamond visible when selected. This 
can be clicked on and dragged to 
change the shape in different ways.

How to add text to a shape
When first created a shape will not 
have a visible cursor inside it for text. 
If you wish to add text, double-click 
inside the box and you can then type 
or paste text straight into it.

Styles can also be applied to the 
content.

If you have clicked off of the text box 
then one click will select the box but it 
requires a double click to make the 
cursor active again within the box.
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Adding a fill (shape only)
To add a fill to your shape you need to 
have the object selected, click on the 
Edit menu and then click the 
dropdown for the Fill color picker. 

Clicking on a color swatch will apply it 
to the selected object.

See our section on the Color picker 
for a full description of how the color 
picker works.

An applied color can also have a 
transparency set here.

Top tip: Previous settings will 
be held in the fill dropdown but will 
not be applied to a new box unless 
re-selected.

Adding a border or 
amending a line
Adding a border to your shape or a 
style, weight and colour to your line, is 
done by selecting the object, clicking 
on the Edit menu and clicking onto the 
rule picker dropdown menu.

Here you can set the rule weight, style 
and color.

Select the rule weight and style before 
picking the color, as once the color is 
selected the panel will close and the 
settings will be applied to your box.

Top tip: Currently, only weights 
from 1pt though to 10pt are 
selectable from the weight menu.
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How to delete
When a shape/line is first created you 
can just click delete to remove it.

If you have unselected the object then 
just clicking on the object once and 
pressing delete will remove it.

If you click and move an object you will 
need to select it again to delete it (a 
line will delete fine).

The box anchor
The box anchor is what links the 
shape/line to the page and can affect 
the shape/lines position. See object 
frames for a full description.

Object Properties
Object properties are where you 
can exactly set size, margins, etc. 
See Object frames for a description.

Top tip: A shape or line can be 
changed to any other shape or line 
in the object properties panel.

Layering and alignment
See Object frames for a description.
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All information, content, and materials available in this document are 
for general informational purposes only. The content on this posting 
is provided "as is;" no representations are made that the content is 

error-free or up to date. Designers should test their design in XHTML 
often and keep back up files at all times.

Written and designed by the Design Centre of Excellence, Workiva

The information contained herein is proprietary to Workiva and cannot be copied,
 published, or distributed without express prior written consent. 

Copyright 2022 Workiva Inc. 
Workiva is a registered trademark of Workiva Inc. 

All rights reserved.

Adobe, Illustrator, InDesign and Photoshop are either registered trademarks or trademarks of Adobe in the United States and/or 
other countries. Microsoft and Word are trademarks of the Microsoft group of Companies. XBRL® and iXBRL™ are trademarks o 
XBRL International, Inc. All rights reserved. The XBRL™/® standards are open and freely licensed by way of the XBRL International 
License Agreement. Our use of these trademarks is permitted by XBRL International in accordance with the XBRL International 
Trademark Policy.
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Workiva Confidential and Proprietary Information

Support contacts
For questions, reach out to your Customer Success manager, or our Support Team.

24/7 Helpdesk

United Kingdom - +44 8000885141 France - +33 801840098 US - 1-877-934-8435

From Europe: 00-800-5005-0080 From the US: 1-800-706-6526

A full list of our global support telephone numbers can be located here Or email our Support Team directly via support@workiva.com

Workiva Inc. (NYSE: WK) simplifies complex work for thousands of organisations worldwide. Customers trust Workiva’s open, intelligent, and intuitive platform to connect 
data, documents and teams. The results: improved efficiency, greater transparency and less risk.
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